Windows Movie Maker 2 - Video Task Guide

This guide will instruct you how to get video footage from a DV camcorder to your computer.
It will also give basic instructions for trimming footage and adding transitions.

Note: There are two versions of Windows Movie Maker. This guide is for version 2. To
determine which version of Movie Maker you have, open Windows Movie Maker (see
Setup/Locating the Program below if you are not sure how to do that), choose About
Windows Movie Maker from the Help menu, and look for the line that begins Windows Movie
Maker Version x.x.xxxx.x (usually the fourth line down). The first number indicates the
version of Windows Movie Maker (for Movie Maker 1, see the Movie Maker 1 Guide).

Setup/Locating the Program

For this process, you will need the following:

Your camcorder
The tapes that contain the footage you have recorded.

A FireWire (also called iLink or IEEE 1394) cable to connect the camcorder to your
computer

Windows XP

To open Windows Movie Maker, click on the Start button in the bottom left part of the screen
and then go to the following menu items:

All Programs/Accessories/Windows Movie Maker

General Tips:

When filming, record a few extra seconds at the beginning and ending of all your scenes
and takes. This will make editing easier.

Video files are very large. Try to keep at least 1-2 GB of space free on your hard drive at
all times. You may want to work with 10 minutes or less of footage at a time. Check the
free space on your hard drive periodically.

Close all other programs before proceeding.
You will probably find it easiest to capture and work on one clip or scene at a time.

Capturing

Open Windows Movie Maker.

Plug your video camcorder into an AC adaptor, turn the camera on to playback mode,
and load the video tape that contains the footage you’d like to capture.

Connect the FireWire cable from the video camcorder to the computer.



Windows Movie Maker should automatically open the capture dialog box. If it doesn't,
choose Capture Video from the File menu. The Capture dialog will open.

Video Capture Wizard: Sony DV Device

Captured Video File .:r..—_
Enter information for your captured video file.

1. Enter a file name For vour captured video.
Linkitled|

2, Choose a place to save your captured video,

g My Wideos V
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Type in a name for the video file.

Choose a save location for your video file by clicking on the Browse button. By default,
Windows Movie Maker will save your file to My Documents/My Videos.

Click on the Next button when you have finished.

Video Capture Wizard: Sony DV Device
Video Setting '7'_'__'
Select the zetting you want to use to capture pour video. The capture setting pou select
determines the quality and size of the captured video.

() Best quality for playback on my computer (recommended)
Use if vou plan to skore and edit video on wour computer.

(® Digital device format (DY-AVI);
Use if vou plan to record vour final movie back ko tape.

() Other settings

Learn more about video settings.

Setting details Video file size
File bype: Audio-Yideo Interleaved (AVI) Each minute of video saved with this setting will
Eit rate: 25.0 Mbps consume 178 MB.

Display size: 720 x 480 pixels
Frames per second: 30
Videao Farmat: NTSC

Disk space available on drive C: 4.86 GB
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In the Video Settings dialog, click on the radio button next to Digital device format
(DV-AVI).



9. Click the Next button.

Video Capture Wizard: Sony DV Device

Capture Method o
Select whether to capture the entire tape automatically or specific parts manually.

(O capture the entire tape automatically

The viden tape rewinds to the beginning and the video is then captured
aukomatically.
() Capture parts of the tape manually:

Cue the video tape to the part of the video you wank to capture and start
the capture process manually. You can capture more than one part of the
video tape without reskarting the wizard.

Show preview during capture
On some camputers, displaying the Preview window during the video capture
can affect the quality of the captured video. If wou find that your captured
video files do not play back smoothly, clear this checkbox,

[ < Back ][ Mext » ][ Cancel ]

10. In the Capture Method dialog, click on the radio button next to Capture parts of the
tape manually. Leave the Show preview during capture box checked. If you
experience problems while capturing the video (skipping or freezing), try coming back to
this screen and clearing the checking the box next to Show preview during capture.

11. Click the Next button.

Video Capture Wizard: Sony DV Device
Capture Video (=
Click the Start Capture button to begin capturing your video. 'ou can capture one or more
video clips.
Skeps: Preview:

i, | Stark Capture |

2. [ Stop Capture ]

3. To capture another videa clip,
repeat steps 1 and 2,

Video captured:  0:00:00
Size of video file: 0 KB

Estimated disk space available:
4,64 GE remaining on drive C: DY camera contrals

= n A4 AD M ee
Create clips when wizard finishes
[Ctute speakers
] Capkure time limit (hh:mm):

Tape position:  0:00:43:15
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12. Make sure the video tape in your camcorder is cued to the right spot.



13.

14.
15.
16.

17.

\A

%

Click the Start Capture button in Windows Movie Maker. The Preview window will show
you what Windows Movie Maker is capturing.

When the footage you're capturing is finished, click Stop Capture.

Click on the Finish button.

Windows Movie Maker will now create clips from the captured video. Clips are created by
Windows Movie Maker when there is a significant change from one frame to another
(usually between scenes or takes).

Once the clips are created, they will appear in the Collection area (the middle part of the
program).

# Untitled - Windows Movie Maker

File Edit Wiew Tools Clp Play Help

L1 ol | E Tasks Collections || Pie Eating

Collection: Pie Eating

Dirag a clip and drop it on the staryboard
Movie Tasks below.

1. Capture Yideo =)

Capture from video device
Irnpatt video

Import pictures

Irmport audio or music

~
2. Edit Movie () Pie Eating
3. Finish Movie )
Movie Making Tips (2

Haow ko capture video
How ta edit clips

How ko add titles, effects, transitions Ry N YT N SN
How to save and share movies m b _/' \—) AL N _/I k,_)
i I T show Timeline

Drag media to the storyboard to begin making a movie.
< >

Ready

If you captured a single scene or clip and if you will be doing all of your editing in the
program you will be using for compressing the video, you may simply close Windows
Movie Maker, locate the AVI file Windows Movie Maker created, and open it in your other
program.

Otherwise, continue to the next section to edit your video clip(s).



1. Drag the first clip that you want to use into the storyboard (the slots at the bottom).
4 Untitled - Windows Movie Maker =X

File Edit “ew Took Clip Play Help
a FH| - ETasks Collections | | Pie Eating
Collection: Pie Eating Pie Eating

Drag a clip and drop it an the storgboard
Collections belov.

i Wideo Effects

[ wideo Transitions o
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) newtest )
8 Pie Eating k

Pie Eating

jf Show Timeling

Lu'lhe storyboard to begin making a movie.

Ready

2. To trim the clip, click on the Show Timeline button.

3. The clip will show up as a rectangular area. The width of the rectangle represents the
length of the clip. Move your mouse near the end or beginning of the rectangle. The
cursor changes to red double arrows.

4. Hold down the mouse button and start dragging left to trim the end of the clip or right to
trim the beginning of the clip. The vertical blue line will show where the trim point is,
while the preview pane in the upper right side of the program will show you the current
video frame to assist you in choosing the trim point.
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Drag a clip and drop it an the timeline
Collections below.
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5. Use this method to choose trim points for the beginning and end of the video clip.

l If you are only using a single clip, you are now ready to save the movie to a file you can
compress in another program. Skip ahead to Save (page 7). As an option, you may
experiment with fades and video effects by choosing from the menu items in the Video
item from the Clip menu.

— If you will be combining multiple clips to create your video, continue to the next section
for instructions on combining clips and putting transitions between them.

Multiple Clips

1. Click on the Show Storyboard button.
2. Drag the next clip you would like to use to the next slot in the storyboard.

) Untitled - Windows Movie Maker =Jo&d

. File Edit  Wiew Tools Clp  Play Help
all TH B - E Tasks Collections | | train
Collection: train 5/19/2004 10:39 AM

Dirag a clip and drop it on the storyboard
Collections below.

g Video Effects ~
D Video Transitions
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) Pie Eating
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3. You may also add a transition between the clips. With the Collections button highlighted
(top icon bar just below the menus), click on Video Transitions from the Collections pane
in the left side of the program. Choose a transition and drag it between your two video
clips. For more information on transitions and video effects, see the Help Topics from the
Help menu.

4. Continue adding clips and transitions, trimming them as needed, until you have
assembled the entire video.



Save

In this final step, we will prepare the video to be compressed in Memories Builder. There is a

difference between the Save Project and Save Movie File menu items on the File menu.

e Save Project - Creates a small file that includes information about which clips you are
using and any transitions, trims, or effects you may be using. Useful for allowing you to
make modifications to those settings later. This file does not contain any actual footage,
and will only be useful on the computer it is created on.

e Save Movie File — The step required to prepare your movie for use in another program.
This process brings all of your clips together and creates a stand-alone movie file.

1. Click on the File menu and choose Save Movie File. The Save Movie Wizard appears.
2. In this screen, choose My computer.

Save Movie Wizard
Movie Location ,";-! \.I
Where do you want to zave your movie to? '\{;
My computer

Save vour mavie[sr plavback on vour computer,

'.f-\ Recordable CO
g Save vour movie For copying to a recordable CD.

E-mail
Save and send your movie as an e-mai attachment by using wour defaulk e-mail pragran.
The Web
Save and send your movie b a videa hosting provider on the \Wieb For others ko watch.
© | DV camera

Record your movie ko a bape in your DY camera for playback an the camera ar ko watch o...

Learn mote abouk saving movies.

3. Click on the Next button. The Saved Movie File dialog appears.

Save Movie Wizard
Saved Movie File ,/.-! \.I
Enter information for your aved mavie file. '\I\:

1. Enter a file name For your saved movie.

Movie

2. Choose a place to save your mavie,

|2 Ciivideo Files d
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4. Type in a name for your movie file. Click on the browse button to choose a location for
the movie file. You may want to choose a different name or location than what you
chose in the Capture portion of this guide, since choosing the same name and location
will overwrite the captured file (you could add edited to the filename, for example).

5. When you have made your choices, click Next. The Movie Setting dialog appears.

Save Movie Wizard
Movie Setting I{! B\
Select the setting you want to use ta save pour movie. The setting you select X ..

determines the quality and file size of your zaved movie.

(3)Best guality For playback on my computer {recommended);

Show E%e choices. ..

Setting details Movie file size

File type: windows Media Yideo (WMY) Estimated space required:

Eit rate: 2,0 Mbps 911 MB

Display size: 720 x 480 pixels

Aspeck ratio: 16:9 Estimated disk space available on drive C:
5.42 GB

Frames per second: 30
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6. Click on Show more choices.

7. Click on the radio button next to Other settings. Then, choose DV-AVI (NTSC) from
the drop-down menu.

Save Movie Wizard
Movie Setting I';! B\
Select the setting you want ta use to save your movie. The setting you select \ .‘

determines the quality and file zize of pour zaved movie.

() Best quality For plavback on my computer (recommended)
() Best fit ta file size:

(%) Cther settings: | Wideo For Pocket PC (215 Kbps) v

Show Fewer choices, |Video far Packet PC (215 Kbps)
Yideo For Packet PC (143 Kbps)
Wideo for Pocket PC (Full screen 218 Kbps)
High quality video {large)

High quality videao (smally

VYideo For local playback (2.1 Mbps)
Wideo for local playback 1.5 Mbps)
Yideo For LAN (1.0 Mbps)

Wideo For LAN (765 Kbps)

Video For broadband (512 Kbps)
Yideo for broadband (340 Kbps)
Wideo for broadband {150 Kbps)

VYideo For ISDN (48 Kbps)
Sething details Wideo for dial-up access (35 Kbps)
' ) Di-AVLENTSCH [
File bype: 'Windows High qualicy video (NT=E% f

Eit rate: 218 Kbps |Video For local playback (2,1 Mbps NTSC)
Display size: 208 x |Mideo for local playback 1.5 Mbps NTSC)

Aspect ratio: 4:3 Estimated disk space available on drive C:
Frames per second: 20 =42 GB
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8. Click on the Next button. Windows Movie Maker begins saving the file.

Save Movie Wizard
Saving Movie ,f._! R\
Your movie iz being saved. 5 ..
Saving mowis...
( ]
35 Seconds Remaining 19 %

Movie file name:

Train Movie

Destination;

Ciivideo Files)

E  Cancel

9. When it has completed, click on the Finish button. Windows Movie Maker will play the
finished file. Note: Playback of uncompressed video requires more processing power and
system resources than many computers can handle. Playback may be choppy on some

machines.
Save Movie Wizard
Completing the Save Movie Wizard ,f._! \.
“You have successfully completed the Save Maovie Wizard and saved vour movie to the ..
place pou specified.
Optional:
gk

To close this wizard, click Finish,

Your movie file is now ready for Memories Builder. Because the exported video file still needs
to be compressed, Memories Builder will prompt you to compress it as you add it to your
project. Follow the instructions in the User’s Guide starting with step 5 on page 29 for
choosing compression settings.

This concludes the Windows Movie Maker Task Guide. For more information on Windows
Movie Maker, consult the Help Topics from the Windows Movie Maker Help menu.
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